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Abstract 

 

Time constraints are often a problem in construction projects. Project scheduling and consistent evaluation 

are needed so that the project is completed on time. Evaluation is applied using performance intensity methods 

and Microsoft Project. Performance Intensity is a calculation carried out to determine the pace of project work. 

Performance intensity provides information on how quickly an activity can be completed. For the calculation of 

Performance Intensity use PPI, API and CPI. To control work in the field using CCS and CCP. 

Evaluation to find out the time performance applied to the Yogyakarta Lighthouse project. The project is planned 

to be completed on December 14, 2014 with a duration of 266 days. Evaluation is carried out for 35 periods. The 

results of this evaluation are differences in the analysis of the final day between the method of Performance 

Intensity and Microsoft project. The final day analysis of Performance Intensity at week 35 for 279 days, while 

analysis of Microsoft Project for 280 days. Differences in the range of predictions for the day-to-day analysis of 

a project are caused by the Performance Intensity method using the average cumulative work rate as a 

benchmark that changes every period. To pursue delays, the project acceleration method is used, namely 

Schedule. The time needed for the Schedule is 80 days. 

 

Keywords : Scheduling,  Performance  Intensity,  Microsoft Project, Delay Analysis, Project Acceleration  

                     Method. 

 

PENDAHULUAN 

 Keterlambatan pelaksanaan proyek 

sering terjadi di lapangan. Keterlambatan 

waktu pelaksanaan proyek tersebut menjadi 

tanggung -jawab kontraktor sebagai 

pelaksana proyek. Apabila keterlambatan 

tersebut dalam jangka waktu yang lama, 

maka bisa saja kontraktor diberikan sanksi 

oleh pemilik proyek karena tidak sesuai lagi 

dengan waktu yang terencana didalam 

dokumen kontrak. cuaca yang tidak 

memungkinkan seperti hujan yang memaksa 

para pekerja tidak dapat melaksanakan 

pekerjaannya, adanya kesalahan ataupun 

perubahan pada perencanaan, keterlambatan 

material yang datang, kurangnya pengawasan 

terhadap para pekerja sehingga terjadi 

kesalahan-kesalahan oleh pekerja, adanya 

peraturan- peraturan pemerintah khususnya 

tentang lalulintas yang memperlambat 

penyelesaian pekerjaan. 

Salah satu cara untuk mengatasi 

keterlambatan adalah menambah waktu kerja 

dengan tenaga kerja yang tersedia. Dengan 

analisa ini kita dapat mengetahui jumlah 

waktu yang dapat dipercepat dan mengetahui 

besar biaya yang dikeluarkan setelah 

melakukan analis percepatan waktu proyek 

serta mengetahui pekerjaan-pekerjaan proyek 

yang membutuhkan percepatan. Pada 

penulisan tugas akhir ini penulis mengambil 

cara mempercepat waktu penyelesaian 

proyek dengan menggunakan metode 

Performance Intensity dan Microsoft Project.  

    Berdasarkan latar belakang yang telah 

dipaparkan diatas, rumusan masalah yang 

bisa diambil sebagai acuan adalah : 

1. Bagaimana menganalisa kinerja proyek 

Mercusuar Gunung Kidul, Yogyakarta 

dengan menggunakan metode 

Performance Intensity ? 

2. Apa perbandingan hasil antara 
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performance intensity dengan Microsoft 

project proyek Mercusuar Gunung 

Kidul,Yogyakarta ? 

3. Apa saja faktor -faktor yang menyebabkan 

keterlambatan proyek Mercusuar Gunung 

Kidul,Yogyakarta? 

Adapun tujuan penulisan ini dilakukan yaitu 

sebagai berikut : 

1. Menghitung kinerja proyek Menara Suar  

dengan menggunakan metode 

performance intensity. 

2. Untuk membandingkan hasil analisa 

performance intensity dengan Microsoft 

project 

  proyek Mercusuar Gunung 

Kidul,Yogyakarta. 

3. Menentukan dan menganalisa faktor-

faktor yang menyebabkan keterlambatan 

pada proyek Mercusuar Gunung Kidul, 

Yogyakarta 

 

Manfaat yang dapat diambil dari penulisan 

ini adalah : 

1. Kontraktor 

Penulisan ini dapat membantu dalam 

memperkirakan penjadwalan suatu 

proyek konstruksi dapat memprediksi 

terjadinya ketelambatan lebih awal. 

2. Untuk Pemerintah 

Mengaplikasikan dan mengoptimalkan 

perhitungan Performance Intensity pada 

suatu proyek konstruksi, supaya metode 

dengan menggunakan perhitungan 

performance intensity dapat digunakan 

sebagai alternatif metode evaluasi 

penjadwalan pada proyek konstruksi di 

Indonesia dan mengidentifikasi faktor 

utama penyebab keterlambatan proyek 

konstruksi di Indonesia. 

 

METODOLOGI 

Momentum Management 

       Momentum management adalah sebuah 

metode baru berbasiskan waktu dengan 

konsep yang mempelajari tentang bagaimana 

cara mengukur hasil sebuah proyek dalam 

jangka waktu tertentu. Momentum 

management mempunyai fokus pada 

menghitung dan mempertahankan sebuah 

momentum aktual sebuah aktivitas bila sudah 

sesuai dengan momentum rencana aktivitas 

tersebut.Metode ini menawarkan sebuah 

inovasi yang unik yang dapat disebut 

Performance Intensity (PI). 

 

Performance Intensity 

Performance Intensity merupakan metode 

penjadwalan barchart yang dimo-difikasi 

dengan menambahkan rumus di 

dalamnya.Menurut Murray (2007)metode 

Performance Intensity adalah perhitungan 

yang dilakukan untuk mengetahu laju 

pekerjaan proyek. Menurut Suryaputra dan 

Susanto (2012) Performance Intensity pada 

teori ini sama halnya dengan kecepatan saat 

mengendarai mobil. 

Performance intensity merupakan inti dari 

perhitungan momentum management yang 

juga sebagai rasio pengukuran. Proses untuk 

menentukan performance intensity 

melibatkan gabungan dari duration-days tiap 

satu kegiatan dan dibagi jumlah hari kerja 

yang ditentukan (time consumption). 

Performance intensity memberikan informasi 

seberapa cepat suatu aktivitas dapat 

diselesaikan. Performance intensity 

mempunyai satuan seperti ‘Miles-per-Hour’ 

yang  mempunyai kemiripan dengan 

kecepatan,dengan demikian kita dapat 

memutuskan untuk memperlambat suatu 

aktivitas dengan tujuan mempercepat 

aktivitas lain supaya mendapat hasil yang 

lebih optimal. Performance intensity dapat 

membantu dalam mengambil keputusan 

untuk langkah selanjutnya. 

Penemuan variabel Performance Intensity  

ini diawali dari keinginan  Murray untuk 

memiliki suatu persamaan untuk 

penjadwalan proyek, yang tidak rumit dan 

familiar untuk semua orang, sehingga mudah 

dimengerti oleh semua orang. Untuk 

menyajikan data penjadwalan proyek, yang 

diperlukan adalah ukuran “waktu” dan bukan 

ukuran jumlah atau volume pekerjaan yang 

tercapai. Oleh karena itu, digunakan duration 

day sebagai salah satu variabel dalam 

rumusan Performance Intensity. Duration-
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days pada dasarnya memiliki arti yang sama 

dengan durasi aktivitas, namun ada sedikit 

perbedaan, yaitu duration-days memiliki 

nilai.. Duration days adalah pencapaian 

volume kerja yang dibutuhkan untuk 

menyelesaikan durasi aktivitas proyek 

sebesar satu hari. Istilah ini disebut juga 

dengan Crew- Day.Work performance adalah 

variabel pembilang pada rumus dasar 

perhitungan performance intensity. Work 

Performance adalah kumpulan atau jumlah 

dari duration days seluruh aktivitas dalam 

suatu periode tertentu. Time consumtion 

adalah variabel penyebut pada rumus dasar 

performance intensity. Time consumtion  

adalah waktu yang digunakan dalam suatu 

periode tertentu.          

 

Rumusan metode Performance Intensity   

 

Rumus Performance Intensity terbagi atas 5 

macam, yaitu: 

1. Planned Performance Intensity (PPI) 

PPI adalah performance intensity yang di 

dapat per satuan waktu berdasarkan jadwal 

yang telah disusun sesuai rencana awal 

PPI       

2. Actual Performance Intensity (API) 

API adalah performance intensity yang di 

hitung berdasarkan jadwal aktual dan 

progress sebenarnya melalui pengamatan di 

lapangan. 

API =                       

3. Catch-up Performance Intensity (CPI) 

CPI adalah perhitungan untuk mengetahui 

performance intensity yang harus dicapai 

pada periode berikutnya. 

CPI  =     

4. Cruise Controlling Setting (CCS) 

CCS adalah rata-rata dari PPI dari awal 

proyek hingga selesai. Digunakan untuk 

mengetahui kebutuhan dari PI yang harus 

diraih tiap waktunya. 

CCS =                    

5.       Cruise Control Period (CCP) 

CCP adalah rata-rata PPI dari awal proyek 

hingga periode saat ini. Digunakan untuk 

mengetahui status waktu proyek sampai pada 

periode yang dihitung sampai akhir periode 

saat ini.  

CCP =  

 

Analisis kinerja waktu dari perhitungan 

Performance Intensity 

1.      Status waktu proyek per periode 

Status proyek per periode dapat diketahui 

dengan membandingkan antara PPI dengan 

API. Dengan melakukan perbandingan 

tersebut, maka dapat diketahui apakah 

kinerja waktu proyek pada periode tersebut 

lebih cepat, atau sama, maupun lebih lambat 

dari jadwal yang direncanakan. 

a. API  PPI 

Kondisi di atas menunjukkan bahwa kinerja 

waktu proyek pada periode tersebut lebih 

lambat dari jadwal yang direncanakan. 

b. API = PPI 

Kondisi di atas menunjukkan bahwa kinerja 

waktu proyek pada periode tersebut sama 

dengan jadwal yang direncanakan. 

c.  API  

Kondisi di atas menunjukkan kinerja waktu 

proyek pada periode tersebut lebih cepat dari 

jadwal yang direncanakan. 

 

2.  Status waktu proyek secara 

keseluruhan 
Status waktu pada proyek keseluruhan dapat 

diketahui dengan membandingkan antara 

API kumulatif rata-rata dari periode awal 

sampai dengan periode yang dihitung dengan 

CCP yang direncanakan untuk dicapai pada 

periode tersebut. Dengan perbandingan 

tersebut dapat diketahui apakah kinerja 

waktu proyek secara keseluruhan sampai 

pada periode tersebut lebih cepat, atau sama 

maupun lebih lambat dari jadwal yang 

direncanakan. Dengan mengetahui kinerja 

waktu proyek secara keseluruhan, maka 

dapat diambil langkah-langkah yang 

diperlukan untuk mempertahankan laju 

proyek sesuai dengan jadwal rencana. 

 

a. API Kumulatif  CCP 

Kondisi di atas menunjukkan bahwa kinerja 

waktu proyek yang dicapai dari awal sampai 
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dengan periode tersebut lebih lambat dari 

pencapaian yang direncanakan sampai 

dengan periode tersebut. 

b. API kumulatif rata-rata =CCP 

Kondisi di atas menunjukkan bahwa kinerja 

waktu proyek yang dicapai dari awal sampai 

dengan periode tersebut sesuai dengan 

pencapaian yang direncanakan sampai 

dengan periode tersebut. 

c. API kumulatif rata-rata   

Kondisi di atas menunjukkan bahwa kinerja 

waktu proyek yang dicapai dari awal sampai 

dengan periode tersebut sesuai dengan 

pencapaian yang direncanakan sampai 

dengan periode tersebut. 

3.      Prediksi selesainya proyek 

Dengan mengetahui API komulatif rata-rata 

yang dicapai sampai dengan periode tersebut 

maka tanggal selesai proyek dapat diprediksi. 

Prediksi hari yang dibutuhkan untuk 

menyelesaikan proyek menurut jadwal aktual 

dihitung dengan membagi sisa total duration-

days aktual dengan API kumulatif rata-rata 

sampai pada periode tersebut. Prediksi hari 

yang didapat dari perhitungan kemudian 

ditambah dengan tanggal akhir periode 

tersebut sehingga mendapatkan  tanggal 

selesainya proyek tersebut. 

Prediksi hari untuk selesai 

=                

Prediksi tanggal selesai =  

        Tanggal akhir periode + hari untuk 

selesai  

Microsoft Project 

Microsoft Project 2013 merupakan sistem 

perencanaan yang dapat membantu dalam 

menyusun penjadwalan (scheduling) suatu 

proyek atau rangkaian pekerjaan. Microsoft 

Project 2013 juga mampu membantu me-

lakukan pencatatan dan pemantauan terhadap 

penggunaan sumber daya (resource), baik 

yang berupa sumber daya manusia maupun 

pera-latan. Yang dikerjakan oleh Microsoft 

Project 2013 antara lain mencatat kebutuhan 

tenaga kerja pada setip sektor, mencatat jam 

kerja para pegawai, jam lembur dan 

menghitung pengeluaran sehubungan dengan 

ongkos tenaga kerja, memasukkan biaya 

tetap, menghitung total biaya proyek, serta 

mem-bantu mengontrol penggunaan tenaga 

kerja pada beberapa pekerjaan untuk 

menghindari overlocation (kelebihan beban 

pada peng-gunaan tenaga kerja). 

       Dalam Microsoft Project 2013 ada 

beberapa istilah khusus, antara lain: 

1. Task 

Task adalah salah satu bentuk lembar kerja 

dalam Microsoft Project 2013 yang berisi 

rincian pekerjaan sebuah proyek. 

2. Duration  

Duration merupakan jangka waktu yang 

diperlukan untuk menyelesaikan suatu 

pekerjaan. 

3. Start  

Start merupakan nilai tanggal dimulainya 

suatu pekerjaan. 

4. Finish  

Dalam Microsoft Project 2013 tanggal akhir 

pekerjaan disebut finish, yang akan diisi 

secara otomatis dari perhitungan tanggal 

mulai (start) ditambah lama pek-erjaan 

(duration). 

5. Predecessor 

Peredecessor merupakan hubungan 

keterkaitan antara satu pekerjaan dengan 

pekerjaan lain. Dalam Microsoft Project 

2013 mengenal 4 macam hubungan antar 

pekerjaan, yaitu : 

a. FS (Finish to Start) 

Suatu pekerjaan baru boleh dimulai jika 

pekerjaan yang lain selesai. 

 
Gambar 2.1. Finish to Start 

b. FF (Finish to Finish) 

Suatu pekerjaan harus selesai bersamaan 

dengan selesainya pekerjaan lain. 

 
Gambar 2.2. Finish to Finish 

c. SS (Start to Start) 

Suatu pekerjaan harus dimulai bersamaan 

dengan pekerjaan lain. 
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Gambar 2.3. Start to Start 

d. SF (Start to Finish) 

Suatu pekerjaan baru boleh diakhiri jika 

pekerjaan lain dimulai. 

 
Gambar 2.4 Start to Finish 

6. Resources 

Pengisian sumber daya, baik sumber daya 

manusia maupun material dalam Microsoft 

Project 2013 disebut dengan resources. 

7. Baseline  

Baseline adalah suatu rencana baik jadwal 

maupun biaya yang telah disetujui dan 

ditetapkan. 

8. Gantt Chart 

Gantt Chart merupakan salah satu bentuk 

tampilan dari Microsoft Project 2013 yang 

berupa batang-batang horizontal yang 

menggambarkan masing-masing pekerjaan 

beserta durasinya. 

9. Tracking  

Tracking adalah mengisikan data yang 

terdapat dilapangan pada perencanaan yang 

telah dibuat. 

 

Penggunaan Microsoft project ini adalah 

untuk menginput data yang nantinya hasil 

dari Microsoft project ini membantu dalam 

pembuktian dan pembanding  hasil dari 

penyelesaian performanced intensity. Untuk 

melakukan analisis dengan metode 

Performance Intensity menggunakan 

Microsoft project dilakukan input data–data 

proyek sebagai berikut: 

a. Memasukkan data –data proyek yang 

akan di tinjau 

b. Mengatur kalender proyek 

c. Menginput durasi setiap kegiatan 

d. Tentukan predecessor atau successor 

dari setiap kegiatan 

e. Buat baseline dan lakukan set baseline 

f. Melakukan tracking untuk mengupdate 

task (input durasi aktual dari setiap task 

kegiatan) 

g. Check hasil dari remaining duration dan 

actual duration pada Microsoft project 

bandingkan dengan hasil pada 

performance intensity yang di dapat. 

 

Keterlambatan Proyek 

 

Banyak penyebab ditundanya penyelesaian 

proyek, seperti yang dikemukakan oleh 

(Nursyam, 2006) diantaranya adalah masalah 

kekurangan material, masalah yang 

disebabkan oleh Konsultan dan klien, dan 

masalah tidak kompetennya konsultan 

Pelaksana. 

Keterlambatan proyek dapat terjadi apabila 

terjadi ketidaksesuaian waktu yang 

dijadwalkan dengan pelaksanaan di lapangan 

(melebihi waktu yang telah direncanakan). 

Pada pelaksanaan proyek konstruksi ada 

banyak hal yang dapat membuat pelaksanaan 

proyek mengalami gangguan sehingga 

berakibat terjadinya keterlambatan waktu 

penyelesaian pekerjaan. Akibat dari 

keterlambatan proyek sering menimbulkan 

tuntutan dari salah satu pihak. 

 

Faktor-Faktor Keterlambatan Proyek 

 

Menurut Proboyo (1999), penyebab – 

penyebab keterlambatan waktu pelaksanaan 

proyek dapat dikategorikan dalam 3 

kelompok yaitu : 

a) Compensable delays 

Keterlambatan yang layak mendapatkan 

ganti rugi (Compensable delays) adalah 

keterlambatan yang diakibatkan oleh 

tindakan, kelalaian atau kesalahan pemilik. 

Pada kejadian ini, kontraktor biasanya 

mendapatkan kompensasi berupa 

perpanjangan waktu. 

b) Excusable delays 

Keterlambatan yang dapat dimaafkan 

(Excusable delays) adalah keterlambatan 

yang disebabkan oleh kejadian-kejadian 

diluar kendali baik pemilik maupun 
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kontraktor. Keterlambatan jenis ini dikenal 

dalam kontrak dengan nama Force Majeure. 

c) Non Excusable delays 

Excusable delays) adalah keterlambatan yang 

diakibatkan oleh tindakan kelalaian atau 

kesalahan kontraktor. 

 

Menurut Wijayanthi (2008) terdapat 

beberapa faktor yang mempengaruhi waktu 

antara lain keterlambatan supply, 

keterlambatan dalam pekerjaan utama 

perkiraan waktu yang tidak wajar, masalah 

teknis dalam mempergunakan waktu, 

peraturan baru yang membutuhkan waktu 

yang diimplementasikan. 

Faktor-faktor yang mempengaruhi dari segi 

sumber daya selama pelaksanaan dilapangan 

yaitu : 

1) Faktor tenaga kerja  

a) Tingkat keahlian pekerja 

b) Perilaku para pekerja 

c) Tingkat keselamatan pekerja 

d) Perilaku para pengawas 

2) Faktor material  

a) Keterlambatan pengiriman material 

kelokasi proyek 

b) Kekurangan material 

c) Kualitas material 

d) Jumlah material yang dikirim tidak 

tepat 

3) Faktor peralatan 

a) Peralatan yang sudah lama (usang) 

b) Perawatan pada peralatan yang kurang 

c) Kesalahan penempatan peralatan  

d) Peralatan yang tidak sesuai 

e) Keterlambatan pengiriman peralatan 

 

Beberapa sebab utama keterlambatan yaitu 

informasi design yang tidak tepat, informasi 

design yang tidak sempurna, investigasi 

lokasi yang tidak sempurna, reaksi klien yang 

lambat, komunikasi yang buruk dilapangan, 

sasaran waktu yang tidak realistis, 

administrasi kontrak yang tidak sempurna, 

kejadian eksternal yang tidak terkendali, 

informasi tender yang tidak lengkap, alokasi 

risiko yang tidak jelas, keterlambatan 

membayarkan upah. 

 

Metode Percepatan Proyek 

       Dalam pelaksanaan proyek konstruksi 

sering terjadi ketidaksesuaian antara jadwal 

rencana dan realisasi di lapangan, sehingga 

menyebabkan  keterlambatan. Banyak faktor 

yang menyebabkan keterlambatan, salah satu 

cara untuk mengantisipasinya dengan 

melakukan percepatan. Dalam melakukan 

percepatan, faktor biaya dan mutu harus 

diperhatikan, sehingga diperoleh biaya 

optimum dan mutu sesuai standar yang 

diinginkan. Percepatan penyelesaian proyek 

harus dilakukan dengan perencanaan yang 

baik. Banyak metode yang dapat dilakukan 

untuk mempercepat pelaksanaan pekerjaan di 

lapangan antara lain: 

1. Metode CPM (Critical Path Method) 

2. Metode PDM ( Precedence Diagram 

Method) 

3. Metode crashing 

4. Metode  Time Cost Trade Off Analysis 

5. Metode Re-shcedule 

 

Metode PengumpulanData 

Pengumpulan data atau informasi dari  

suatu pelaksanaan proyek konstruksi yang  

sangat bermanfaat untuk evaluasi  

percepatan waktu penyelesaian . Data  

yang diperlukan adalah data sekunder yaitu  

data yang diperoleh dari instansi yang  

terkait seperti kontraktor, konsultan  

pengawas, dan lain-lain. Adapun data-data  

yang dibutuhkan antara lain: 

1. Schedule Rencana 

2. Schedule Aktual 

3. Laporan Harian 

4. Laporan Mingguan  

 

Metode Pengolahan Data 

 

Adapun rumus yang digunakan dalam 

analisa metode Performance Intensity ini 

adalah: 

1. Planned Performance Intensity (PPI) 

PPI  

2. Actual Performance Intensity (API) 

API =  

3. Catchup Performance Intensity(CPI) 
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CPI=  

4. Cruise Controlling Setting (CCS) 

CCS =  

5. Cruise Control Period (CCP) 

CCP= 

 

6. Prediksi hari untuk selesai 

=  

7. Prediksi tanggal selesai =  

Tanggal akhir periode + hari untuk selesai 

 

 
        

HASIL DAN PEMBAHASAN 

Menghitung Nilai Performance Intensity 

 

a. Planned Performance Intensity (PPI) 

PPI adalah performance intensity yang di 

dapat per satuan waktu berdasarkan jadwal 

yang telah disusun sesuai rencana awal. 

Adapun rumus PPI yang di gunakan adalah : 

PPI  

        =   

        = 0.074 % /hari 

b. Actual Performance Intensity (API) 

API adalah performance intensity yang di 

hitung berdasarkan jadwal aktual dan 

progress sebenarnya melalui pengamatan di 

lapangan. Adapun rumus yang digunakan 

untuk menghitung API adalah : 

API =  

        =   

        =  0.055 %/hari 

c. Catch up Performance Intensity (CPI) 

CPI adalah perhitungan untuk mengetahui 

performance intensity yang harus dicapai 

pada periode berikutnya. Adapun rumus yang 

digunakan untuk perhitungan CPI adalah : 

CPI=  

        =  

        = 0.002 %/hari 

d. Cruise Controlling Setting (CCS) 

CCS adalah rata-rata dari PPI dari awal 

proyek hingga proyek selesai. Digunakan 

untuk mengetahui kebutuhan dari PI yang 

harus diraih tiap waktunya. 

CCS =  

         =  

         = 0.074 %/hari 

e. Cruise Control Period (CCP) 

CCP adalah rata-rata PPI dari awal proyek 

hingga periode saat ini.Digunakan untuk 

mengetahui status waktu proyek sampai pada 

periode yang ditinjau. Adapun rumus yang 

digunakan adalah:   
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CCP = 

 

        =  

        = 0.055%/hari 

f. Prediksi hari untuk selesai  

=  

   =  

   =  2.33 hari 

g. Prediksi tanggal selesai     

= Tanggal akhir periode + hari untuk selesai 

   = 23 Maret 2014 + 2.33 hari 

  =  25 Maret 2014 

 

 

h. Prediksi durasi selesai         

= waktu rencana + prediksi selesai 

kumulatif 

       = 266 hari +2.33 hari 

       = 268. 33hari 

       = 268 hari 

Menyusun Rencana Jadwal dan Biaya 

Proyek 

       Dalam menyusun rencana jadwal dan 

proyek ini, dilakukan penginputan data untuk 

menentukan lintasan kritis proyek dengan 

program Microsoft Project 2013. Langkah-

langkah yang dilakukan untuk menyusun 

rencana jadwal dan biaya pada Microsoft 

Project 2013 sebagai berikut : 

1. Membuka lembar kerja baru 

2. Menginput tanggal dimulainya proyek 

dengan menu Project > Project 

Information. 

3. Memasukkan data kegiatan proyek dengan 

mengetikkannya pada kolom Task Name 

dan waktu kegiatan pada kolom Durasi. 

4. Memasukkan hubungan antar pekerjaan 

satu dengan lainnya pada kolom 

Predecessor. 

5. Menyusun kalender kerja untuk menen-

tukan hari kerja dan jam kerja. 

6. Menampilkan lintasan kritis awal dengan 

menu Ganttchart Wizard > Critical 

Path > Finish > Format it. 

7. Menampilkan tampilan tracking untuk 

menentukan lintasan kritis baru pada batas 

minggu yang ditinjau penulis. 

a. Klik icon View > Table lalu Tracking. 

b. Input prestasi item pekerjaan pada 

kolom % compl. berdasarkan laporan 

mingguan pada proyek.  

8. Setelah tracking dilakukan maka dapat 

diketahui hari yamh ndibutuhkan untuk 

menyelesaikan proyek. 

Alternatif Percepatan 

       Setelah dilakukan perhitungan dengan 

metode performance intensity dan Microsoft 

project yang dapat memprediksi waktu 

penyelesaian proyek diketahui bahwa sampai 

dengan evaluasi minggu ke-35 kondisi 

proyek sangat tidak baik, penyimpangan 

yang terjadi besar, yaitu: Penyimpangan 

terhadap waktu pelaksanaan. Berdasarkan 

perhitungan waktu penyelesaian proyek 

dengan menggunakan metode performance 

intensity, pada minggu ke-35  proyek 

diperkirakan akan selesai dalam waktu 279 

hari , sedangkan pada Microsoft project 

diketahui bahwa proyek diperkirakan akan 

selesai dalam waktu 280 hari, Dalam 

perencanaan waktu rencana proyek adalah 

266 hari, ini menunjukkan bahwa proyek 

mengalami keterlambatan yang sangat besar 

dari jadwal rencana yang diperkirakan yaitu 

selama 14 hari. Untuk itu perlu dilakukan 

tindakan atau solusi untuk mempercepat 

pelaksanaan pekerjaan. 

Dalam kasus keterlambatan proyek 

mercusuar ini maka penulis mengambil 

solusi untuk mempercepat waktu 

penyelesaian proyek yaitu dengan Re-

schedule. Pengendalian jadwal dilakukan 

setelah pelaksanaan proyek tanggal 17 

November 2014. Penjadwalan ulang 

dilakukan dengan menerapkan kerja lembur 

pada kegiatan-kegiatan yang berpengaruh 

pada durasi penyelesaian proyek (kegiatan 

kritis). Re-schedule dilakukan dengan asumsi 
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proyek tetap berjalan selama 24 jam tetapi 

tenaga kerja nya bergantian (Shift kerja). Re-

schedule dilakukan pada minggu ke 36 

sampai dengan minggu ke-38. Kegiatan yang 

di Re-schedule adalah kegiatan yang belum 

mencapai bobot 100%. 

Berdasarkan uraian di atas maka 

dilakukan re-schedule dengan Microsoft 

Project. Adapun langkah-langkah untuk Re-

schedule adalah: 

1. Membuat schedule baru dari batas 

tracking terakhir dengan terlebih dahulu 

mengatur tanggal mulai re-schedule 

dengan pilih menu project,lalu pilih 

ikon project information. Pada kasus 

ini tanggal terakhir batas tracking adalah 

16 November 2014 maka untuk start 

date nya di mulai pada tanggal 17 

November 2014. 

2. Setelah tanggal mulai nya re-schedule di 

inputkan, isi task name pekerjaan yang 

belum mencapai  bobot 100% pada batas 

tracking terakhir dengan menginput 

durasi dari remaining duration 

3. Masukkan predesessor 

4. Untuk melakukan solusi yang di pilih 

dengan proyek bekerja selama 24 jam 

maka klik menu project ,lalu pilih ikon 

project information setelah itu ubah 

calendar dengan 24 hours > oke 

5. Pilih ikon change working time ubah 

for calendar menjadi 24 hours > oke 

6. Maka di dapatkan tanggal finish proyek 

hasil re-schedule sama dengan tanggal 

finish rencana. 

SIMPULAN 

      Berdasarkan data serta hasil analisis dan 

pembahasan yang dilakukan untuk 

percepatan waktu penyelesaian proyek 

dengan perbandingan hasil metode 

performance intensity dan Microsoft project 

pada proyek Mercusuar,Yogyakarta, dapat 

diambil kesimpulan sebagai berikut : 

1. Performance Intensity metode 

penjadwalan barchart yang dimodofikasi 

dengan menambahkan rumus di 

dalamnya. Performance intensity adalah 

perhitungan yang dilakukan untuk 

mengetahui laju pekerjaan proyek. 

Dengan Performance Intensity dapat 

diketahui kecepatan kerja tiap periode dan 

status proyek. 

2. Dengan metode performance intensity 

dengan jadwal rencana sampai akhir 

pengamatan periode 35 proyek diprediksi 

akan berakhir pada tanggal 29 November 

2014. Sedangkan pada jadwal rencana 

sampai akhir pengamatan  akan berakhir 

pada tanggal 16 November 2014. Total 

durasi untuk menyelesaikan proyek 

sampai dengan minggu ke-35 adalah 279 

hari.Pada perhitungan Performance 

Intensity, proyek mengalami 

keterlambatan selama 13 hari 

3. Dengan Microsoft Project, pada jadwal 

rencana awal sampai dengan pengamatan 

periode 35 proyek di prediksi akan selesai 

pada tanggal 28 Desember 2014. 

Sedangkan jadwal rencana sampai akhir 

pengamatan pada tanggal 14 Desember 

2014. Total durasi yang dibutuhkan untuk 

menyelesaikan semua pekerjaan dengan 

Microsoft Project selama 280 hari.Pada 

perhitungan Microsoft Project, proyek 

mengalami keterlambatan selama 14 hari. 

4. Faktor penyebab keterlambatan pada 

proyek Mercusuar ini adalah pada minggu 

pertama tidak fullnya waktu realisasi di 

lapangan,sehingga bobot kumulatif 

rencana lebih besar dari bobot aktual, 

waktu libur lebaran yang lama, 

predecessors. 

SARAN 

Dalam penulisan tugas akhir ini, masih 

banyak tersapat kekurangan diperlukan 

penyempurnaan. Berikut ini beberapa saran 

yang dikemukakan sehubungan dengan tugas 

akhir ini antara lain:  

1. Perlu dilakukan dan pengembangan lebih 

lanjut mengenai metode performance 

intensity yang merupakan bagian dari 

momentum management pada proyek 

konstruksi di Indonesia sehingga dapat 



Jurnal Ilmiah Poli Rekayasa Volume 14, Nomor 2, Oktober 2019 ISSN : 1858-3709 

 

 

58 

digunakan sebagai analisa dan evaluasi 

kinerja waktu. 

2. Semakin banyak data yang dianalisa dan 

dievaluasi, hasil analisa metode 

performance intensity untuk prediksi 

tanggal selesai proyek lebih mendekati 

kejadwal rencana. 

3. Untuk pembuatan hubungan 

ketergantungan (predecessor) pada 

Microsoft project hendaknya dilakukan 

secara teliti agar diperoleh hasil analisis 

yang akurat. 

4. Untuk mendapatkan hasil analisa 

keterlambatan yang lebih baik,sebaiknya 

dilakukan update jadwal tiap akhir periode 

untuk periode berikutnya. Agar pekerjaan 

memenuhi target yang diinginkan, 

diperlukan perencanaan jadwal yang 

baik,manajemen sumber daya yang teratur 
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